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POWERPOINT

PREPARING A PRESENTATION

Section 1
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Links to 

Activities

1.1
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1.6
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1.8

1.9

1.10

Skills

• Complete the presentation cycle

• Choose a design theme

• Add a new slide to a presentation

• Navigate in a presentation

• Insert a slide in a presentation

• Change the presentation view

• Change the slide layout
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Links to 
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1.1
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1.3

1.4

1.5

1.6

1.7

1.8
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1.10

Skills

• Use the Help feature

• Check spelling in a presentation

• Use Thesaurus to display synonyms for words

• Run a presentation and use the pen and highlighter 

during a presentation

• Add transition and sound to a presentation

• Print and preview a presentation
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Links to 

Activities

1.1

1.2
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1.4

1.5
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1.7

1.8

1.9
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Completing the Presentation Cycle

• To open PowerPoint click Start on Windows 

Taskbar, point to All Programs, point to Microsoft 

Office, then click Microsoft Office PowerPoint 2007.

• At PowerPoint window, click Office      then click 

New.

• At New Presentation

dialog box, click Installed

Templates in left panel

then double-click

Introducing PowerPoint

2007 template.

ACTIVITY

1.1
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Completing the Presentation Cycle

• PowerPoint Window

ACTIVITY

1.1

Office button

Status bar

Slides/Outline

pane

Quick Access Toolbar Title bar

Ribbon

Scroll box

View area

Tabs

Placeholder

Slide pane

Notes pane

Vertical

scroll bar
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1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9
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PowerPoint Window Elements

• Office button displays as a Microsoft Office logo 

and, when clicked, displays a list of options and 

most recently opened presentations.

• Quick Access toolbar contains buttons for 

commonly used commands.

• Title bar displays file name followed by program 

name.

• tabs contain commands and features organized into 

groups.

• ribbon area containing the tabs and commands 

divided into groups.

ACTIVITY

1.1
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1.1

1.2

1.3
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1.6
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1.8

1.9

1.10

PowerPoint Window Elements

• Slides/Outline pane displays at the left side of the 

window with two tabs—Slides and Outline. With the 

Slides tab selected, slide miniatures display in the 

pane; with the Outline tab selected, presentation 

contents display in the pane.

• Slide pane displays the slide and slide contents.

• Notes pane adds notes to a presentation in this 

pane.

• vertical scroll bar displays specific slides using this 

scroll bar.

• horizontal scroll bar shifts text left or right in the 

Slide pane.

ACTIVITY

1.1
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Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

PowerPoint Window Elements

• I-beam pointer used to move the insertion point or 

to select text.

• insertion point indicates location of next character 

entered at the keyboard.

• View area located toward right side of Status bar 

and contains button for changing presentation view.

• Status bar displays number of pages and words, 

View buttons, and Zoom slider bar.

ACTIVITY

1.1
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Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Completing the Presentation Cycle

• To run presentation click Slide Show tab then click 

From Beginning button.

• When first slide fills screen,

read then click left mouse

button. Continue reading each slide and clicking left 

mouse button. When a black screen displays, click 

left mouse button to end slide show.

• Save presentation by clicking Save.

• At Save As box, make PowerPointS1 folder on your 

storage medium active, type MPPowerPoint2007 in 

File name box, then press Enter.

ACTIVITY

1.1
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Completing the Presentation Cycle

• Print presentation information in outline view by 

clicking Office then clicking Print.

• Click down-pointing arrow

to right of Print what option

then click Outline View.

• Click OK to close.

• Close presentation by

clicking Office 

then clicking Close.

• To Close PowerPoint click

Office then click Exit PowerPoint in lower right 

corner.

ACTIVITY

1.1
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1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Choosing a Design Theme; Creating Slides;

Closing a Presentation

• Open PowerPoint.

• Click Design tab.

• Click More button at right side of Themes icons.

• Click Verve at 

drop-down gallery.

ACTIVITY

1.2
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Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Choosing a Design Theme; Creating Slides;

Closing a Presentation

• Click anywhere in text Click to add title that displays 

in slide in Slide pane then type Marquee 

Productions.

• Click anywhere in text Click to add subtitle that 

displays in slide then type Movie Production 

Meeting.

ACTIVITY

1.2
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1.8

1.9
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Choosing a Design Theme; Creating Slides;

Closing a Presentation

• Click Home tab then click New

Slide button.

• Click anywhere in text Click to

add title then type Agenda.

• Click anywhere in text

Click to add text then type

Production Schedule.

• Press Enter then type text

shown, pressing Enter

after each item except the

last: Production Assignments, Locations, and 

Summary.

ACTIVITY

1.2
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Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Insertion Point Movement Commands

• Press Left Arrow to move one character left

• Press Right Arrow to move one character right

• Press Up Arrow to move one line up

• Press Down Arrow to move one line down

• Press Ctrl + Left Arrow to move one word to left

• Press Ctrl + Right Arrow to move one word to right

• Press End to move to end of a line of text

• Press Home to move to beginning of a line of text

ACTIVITY

1.2
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Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Insertion Point Movement Commands

• Press Ctrl + Up Arrow to move to beginning of 

current paragraph in placeholder

• Press Ctrl + Up Arrow twice to move to beginning of 

previous paragraph in placeholder

• Press Ctrl + Down Arrow to move to beginning of 

next paragraph in placeholder 

• Press Ctrl + Home to move to beginning of text in 

placeholder

• Press Ctrl + End to move to end of text in 

placeholder

ACTIVITY

1.2
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1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Choosing a Design Theme; Creating Slides;

Closing a Presentation

• Click New Slide in Home tab.

• Click Outline tab toward top of Slides/Outline pane.

ACTIVITY

1.2
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Choosing a Design Theme; Creating Slides;

Closing a Presentation

• Click in Slides/Outline pane

immediately right of slide

icon after number 3, type

Locations, then press Enter.

• Press Tab, type Studio Shoots,

then press Enter.

• Press Tab, type Vancouver

Studio, then press Enter.

• Type Los Angeles Studio then press Enter.

ACTIVITY

1.2
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1.7

1.8

1.9

1.10

Choosing a Design Theme; Creating Slides;

Closing a Presentation

• Press Shift + Tab, type

Location Shoots, then

press Enter.

• Press Tab, type Stanley Park,

then press Enter.

• Type Downtown Streets.

ACTIVITY

1.2
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Choosing a Design Theme; Creating Slides;

Closing a Presentation

• Click anywhere in text Click to add notes in Notes 

pane then type Camille Matsui will report on the 

park location.

• Click Slides tab toward top of Slides/Outline pane.

• Click Save.

• At Save As box, make PowerPointS1 folder on your 

storage medium active, type PPS1-01 in File name

box, then press Enter.

• Close presentation by clicking Office button then 

clicking Close.

ACTIVITY

1.2
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Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Opening, Navigating, and Inserting Slides 

in a Presentation

• Click Open on Quick Access toolbar.

• At Open box, make PowerPointS1 folder active then 

double-click PPS1-01.pptx.

• Open PPS1-01.pptx then

click Next Slide at bottom of

vertical scroll bar.

• Click Previous Slide near

bottom of vertical scroll bar

to display Slide 1.

• To display Slide 2 in Slide pane click Next Slide at 

bottom of vertical scroll bar.

ACTIVITY

1.3
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Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Opening, Navigating, and Inserting Slides 

in a Presentation

• To insert a new slide between Slides 2 and 3 click 

New Slide      in Home tab.

• Click anywhere in Click

to add title in Slide pane

then type Production

Schedule.

• Click anywhere in Click

to add text then type

bulleted text as shown.

Press Enter after each

item except last item.

ACTIVITY

1.3

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Opening, Navigating, and Inserting Slides 

in a Presentation

• Click Outline tab.

• Click immediately right of text

Music, press Enter, then press

Shift + Tab.

• Type Production Assignments,

press Enter, then press Tab. Type

remaining text for Slide 4 as

shown. Do not press Enter after

typing Extras.

• Click Save on Quick Access

toolbar to save PPS1-01.pptx.

ACTIVITY

1.3
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Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Changing Views; Choosing a Slide Layout

• Open PPS1-01.pptx, select

Outline tab.

• Click immediately right of Location

Shoots in third slide.

• Press Enter then type Editing.

• To display slides in Notes Page view click View tab 

then click Notes Page.

ACTIVITY

1.4
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Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Changing Views; Choosing a Slide Layout

• Click Next Slide on vertical scroll bar until Slide 5 

(the last slide) displays.

• To increase zoom click Zoom in View tab, click 

100% at Zoom dialog box, then click OK.

ACTIVITY

1.4
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1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Changing Views; Choosing a Slide Layout

• Change zoom by positioning mouse pointer on 

Zoom slider bar at right side of Status bar. Hold 

down left mouse button, drag right until zoom 

percentage displays as approximately 136%, then 

release.

• Click minus symbol inside a circle at left side of 

Zoom slider bar until 70% displays.

ACTIVITY

1.4
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Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Changing Views; Choosing a Slide Layout

• To view all slides in presentation in slide

miniature click Slide Sorter      .

• Click Normal      in Presentation

Views group.

• Click Slides tab in Slides/Outline pane.

• Click below Slide 5 miniature in

Slides/Outline pane.

ACTIVITY

1.4
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Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Changing Views; Choosing a Slide Layout

• Click Home tab, click

New Slide arrow, then

click Title Slide layout.

• Click Click to add title

then type Production

Leader.

• Click Click to add

subtitle then type

Chris Greenbaum.

• Save PPS1-01.pptx.

ACTIVITY

1.4
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Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Changing the Slide Layout:

Selecting and Moving a Placeholder

• Open PPS1-01.pptx, make Slide 6 display in Slide 

pane.

• Click Layout in Home tab then click Title and 

Content.

ACTIVITY

1.5
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Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Changing the Slide Layout:

Selecting and Moving a Placeholder

• Click immediately right of r in Leader, press 

Backspace key until Leader is deleted, then type 

Team.

• Click immediately right

of m in Greenbaum.

• Type a comma (,), press

spacebar, then type

Production Manager.

• Press Enter then type remaining names and titles 

shown.

ACTIVITY

1.5
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Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Changing the Slide Layout:

Selecting and Moving a Placeholder

• Click Previous Slide on vertical scroll bar until

Slide 4 displays.

• To change slide layout click Layout then click Title 

Slide layout.

ACTIVITY

1.5
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Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Changing the Slide Layout:

Selecting and Moving a Placeholder

• Click anywhere in

Production Assignments.

• To decrease size of

placeholder, position

mouse pointer on middle

sizing handle at left side

until pointer turns into

double-headed arrow. Hold down left mouse button, 

drag right until placeholder border is positioned left 

of n in Production, then release.

• Click anywhere in Locations then drag left side of 

placeholder border until positioned one-half inch left 

of beginning of text.

ACTIVITY

1.5
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Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Changing the Slide Layout:

Selecting and Moving a Placeholder

• To move title placeholder so it positions title as 

shown, position mouse pointer on border of 

placeholder until mouse pointer displays as four-

headed arrow, hold down left mouse button, drag to 

location shown, then release.

• Move content

placeholder so it

positions text as shown.

• Click outside placeholder

to deselect.

• Save PPS1-01.pptx.

ACTIVITY

1.5
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Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Using Help; Checking Spelling;

Using the Thesaurus

• Open PPS1-01.pptx, position mouse pointer on 

scroll box on vertical scroll bar, hold down left 

mouse button, drag scroll box to bottom, then 

release mouse button.

• Click New Slide in Home tab.

• Click Click to add title

then type Summary.

• Click Click to add text

then type text shown.

ACTIVITY

1.6
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Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Using Help; Checking Spelling;

Using the Thesaurus

• To learn how to complete a spelling check click 

Microsoft Office PowerPoint Help      in upper right 

corner of screen.

• At PowerPoint Help

window, type spell

checking then press

Enter.

• Click Check spelling

and grammar in

PowerPoint Help window.

• Read information about spell checking then click 

Close.

ACTIVITY

1.6

spell checking

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Using Help; Checking Spelling;

Using the Thesaurus

• To complete a spelling check, move insertion point 

to beginning of Timetable, click Review tab, then 

click Spelling button       .

• When spelling checker selects Asignments in

Slide 7 and displays Assignments in Change to box, 

click Change.

ACTIVITY

1.6

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Spelling Dialog Box Options

• Ignore skips that occurrence of word and leaves 

currently selected text as written

• Ignore All skips that occurrence of word and all 

other occurrences of word in presentation

• Delete deletes currently selected word(s)

• Change replaces selected word in sentence with 

selected word in Suggestions list box

• Change All replaces selected word with selected 

word in Suggestions list box and all other 

occurrences of word in presentation

ACTIVITY

1.6
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Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Spelling Dialog Box Options

• Add adds selected word to main spelling check 

dictionary

• Suggest moves insertion point to Suggestions list 

box where you can scroll through list of suggested 

spellings

• AutoCorrect inserts selected word and correct 

spelling of word in AutoCorrect dialog box

• Options displays a dialog box with options for 

customizing a spelling check

ACTIVITY

1.6

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Using Help; Checking Spelling;

Using the Thesaurus

• When spelling checker selects second and in slide, 

click Delete.

• When spelling checker selects Budgget in Slide 7 

and displays Budget in Change to box, click 

Change button.

ACTIVITY

1.6

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Using Help; Checking Spelling;

Using the Thesaurus

• When spelling checker selects Greenbaum and 

Almonzo in Slide 6, click Ignore.

• At message that spelling check is complete, click 

OK.

ACTIVITY

1.6

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Using Help; Checking Spelling;

Using the Thesaurus

• Display Slide 7 in Slide pane then click Timetable.

• To look up synonyms for Timetable click Thesaurus

in Proofing group.

• Position mouse pointer on schedule in Research 

task pane, click down-pointing arrow, then click 

Insert.

• To close Research task pane click Close.

ACTIVITY

1.6

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Using Help; Checking Spelling;

Using the Thesaurus

• Right-click on Tasks, point to Synonyms, then click 

responsibilities.

• Capitalize r in responsibilities.

• Save PPS1-01.pptx.

ACTIVITY

1.6

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Running a Presentation

• Open PPS1-01.pptx, click Slide Show tab then click 

From Beginning.

• After viewing Slide 1, click left mouse button to 

advance to next slide, then repeat for Slide 2.

ACTIVITY

1.7
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Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Running a Presentation

• At Slide 3, move mouse pointer until Slide Show 

toolbar displays then click left arrow button to 

display previous slide.

• Click right arrow button on Slide Show toolbar to 

display next slide.

• To display previous slide click right

mouse button then click Previous

at shortcut menu.

ACTIVITY

1.7

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Running a Presentation

• Click on slide icon then click Help to display Slide 

Show Help Window and click Close after viewing 

window.

ACTIVITY

1.7

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Running a Presentation

• To display next slide click slide icon on Slide Show 

toolbar then click Next.

• To display Slide 5 type 5

then press Enter.

• Change to a black screen

by typing B.

• Return to Slide 5 by typing B.

• Click left mouse button to display Slide 6. Continue 

clicking left mouse button until a black screen 

displays, then click left mouse button again.

ACTIVITY

1.7

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Running a Presentation

• Drag scroll box up to top of vertical scroll bar then 

release.

• To display Slide 2 click Next Slide.

• Click From Current Slide       in Slide Show tab.

• To run presentation, click left mouse button at each 

slide. At black screen, click left mouse button again.

ACTIVITY

1.7

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Using the Pen and Highlighter

during a Presentation

• Open PPS1-01.pptx, click From Beginning in Slide 

Show tab.

• With first slide displayed, click left

mouse button to advance slides

until Slide 3 displays.

• Move mouse to display Slide Show toolbar, click 

pen button, then click

Felt Tip Pen.

• Using mouse, draw a circle

around text Location Shoots,

then draw a line below

Dubbing.

ACTIVITY

1.8

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Using the Pen and Highlighter

during a Presentation

• To erase pen markings click pen

button on Slide Show toolbar then

click Erase All Ink on Slide.

• To change color of ink,

click pen button, point

to Ink Color, then click

bright yellow color.

ACTIVITY

1.8
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Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Using the Pen and Highlighter

during a Presentation

• Draw a yellow line below Music.

• To return mouse pointer to an arrow click pen 

button then click Arrow at pop-up list.

• Click left mouse button to advance to Slide 4.

• Click pen button then click Highlighter at pop-up list.

ACTIVITY

1.8

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Using the Pen and Highlighter

during a Presentation

• Drag through Locations

to highlight it.

• Drag through Costumes

to highlight it.

• To return mouse pointer

to an arrow click pen button

then click Arrow.

• Press Esc key on keyboard to end presentation 

without running remaining slides. At message 

asking if you want to keep annotations, click 

Discard.

ACTIVITY

1.8

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Adding Transition and Sound

• Open PPS1-01.pptx, click Animations tab.

• Click More button at right side of

transition icons in Transition to

This Slide group.

• At drop-down gallery, click Newsflash.

ACTIVITY

1.9

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Adding Transition and Sound

• Click down-pointing arrow at right side of Transition 

Sound.

• At drop-down gallery,

click Click.

• Click down-pointing arrow at right of Transition 

Speed button then click Medium.

• Click Apply To All.

ACTIVITY

1.9

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Adding Transition and Sound

• Click Slide 1 miniature in Slides/Outline pane.

• To run presentation click Slide Show in View area 

on Status bar.

• Click left mouse button to advance each slide.

• At black screen after last slide, click left mouse 

button again to return to Normal view.

ACTIVITY

1.9

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Adding Transition and Sound

• Click More button at right of transition icons.

• Scroll down drop-down gallery then

click Random Transition.

• Click down-pointing arrow at right

of Transition Speed then click Fast.

• Click Apply To All.

• Run presentation.

• Save PPS1-01.pptx.

ACTIVITY

1.9
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Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Printing and Previewing a Presentation; 

Changing Page Setup

• Open PPS1-01.pptx, display Slide 1 in Slide pane, 

click Office, point to Print, then click Print Preview.

• Click Next Page in Print Preview tab.

ACTIVITY

1.10

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Printing and Previewing a Presentation; 

Changing Page Setup

• To print all slides on one page and preview how 

they will appear, click down-pointing arrow below 

Print What box, then click Handouts (9 Slides Per 

Page).

• Click Print in Print Preview tab.

• At Print box, click OK.

• Click Close Print Preview.

ACTIVITY

1.10

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Printing and Previewing a Presentation; 

Changing Page Setup

• To print all slide text on one page, click Office then 

click Print.

• At Print box, click down-pointing

arrow at right side of Print what

option then click Outline View.

• Click OK.

ACTIVITY

1.10

© Paradigm Publishing Inc.

Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Printing and Previewing a Presentation; 

Changing Page Setup

• To change slide orientation from landscape to 

portrait click Design tab, click Slide Orientation, 

then click Portrait.

ACTIVITY

1.10
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Links to 

Activities

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

1.9

1.10

Printing and Previewing a Presentation; 

Changing Page Setup

• To print Slide 6, click Office then click Print.

• At Print box, click down-pointing arrow at right side 

of Print what option then click Slides.

• Click Slides option in Print range

section, type 6 in text box, then

click OK.

• To return orientation for slides to

landscape click Slide Orientation

in Design tab then click Landscape.

• Save PPS1-01.pptx.

• To close presentation click Office then click Close.

ACTIVITY

1.10
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